Mathematics – Grade Level Assessments and Content Expectations

Grade Seven - Session 4
Similarity

Participant Packet

Modules Developed by Macomb County Teachers under the leadership of Marie Copeland
M-GLAnCE Project Directors

Debbie Ferry  
Macomb ISD  
Mathematics Consultant

Carol Nowakowski  
Retired  
Mathematics Consultant  
K-4 Project Coordinator

Marie Copeland  
Warren Consolidated  
Macomb MSTC  
5-8 Project Coordinator

2004 Project Contributors

David Andrews  
Chippewa Valley Schools

William Ashton  
Fraser Public Schools

Lynn Bieszki  
Chippewa Valley Schools

Sharon Chriss  
Romeo Schools

Kimberly DeShon  
Anchor Bay School District

Barbara Diliegghio  
Retired, Math Consultant

Kimberly Dolan  
Anchor Bay School District

Jodi Giraud  
L’Anse Creuse Schools

Julie Hessell  
Romeo Schools

Amy Holloway  
Clintondale Schools

Barbara Lipinski  
Anchor Bay School District

Linda Mayle  
Romeo Schools

Therese Miekstyn  
Chippewa Valley Schools

James Navetta  
Chippewa Valley Schools

Gene Ogden  
Anchor Bay School District

Rebecca Phillion  
Richmond Comm. Schools

Charlene Pitrucelle  
Anchor Bay School District

Shirley Starman  
Van Dyke Public Schools

Ronald Studley  
Anchor Bay School District

2005 and 2006 Session/Module Developers

Carol Nowakowski  
Retired, Math Consultant

Deb Barnett  
Lake Shore Public Schools

Luann Murray  
Genesee ISD

Kathy Albrecht  
Retired, Math Consultant

Jo-Anne Schimmelpfeneg  
Retired, Math Consultant

Marie Copeland  
Warren Consolidated

Terri Faitel  
Trenton Public Schools

Debbie Ferry  
Macomb ISD
<table>
<thead>
<tr>
<th>Grade 7 – Session #4  Similarity</th>
<th>G.TR.07.04</th>
<th>G.TR.07.05</th>
<th>G.TR.07.06</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve problems about similar figures and scale drawings</td>
<td>Show that two triangles are similar using the criteria; corresponding angles are congruent (AAA similarity); the ratios of two pairs of corresponding sides are equal and the included angles are congruent (SAS similarity); ratios of all pairs of corresponding sides are equal (SSS similarity); use these criteria to solve problems and to justify arguments</td>
<td>Understand and use the fact that when two triangles are similar with scale factor of ( r ), their areas are related by a factor of ( r^2 )</td>
<td></td>
</tr>
</tbody>
</table>

**Instructional Sequence:**

```
Definition of similarity

Solve problems ➔ Make Scale Drawings ➔ Relate area of similar figures

Develop SSS, SAS, AA similarity
```
Important Tips

• Explore the concept of similarity in as many different ways as possible, i.e. patty paper, measuring polygons and the Geometer’s Sketchpad. This concept is extremely difficult for students and they need varied experiences.
• It is helpful to extend the concept of similarity over an extended period of time. Possibly go back to it after another concept has been explored.
• Do short writing/drawing assignments to assess students’ understanding of similarity throughout the unit and even later in the school year.
• It is important to have students measure as much as possible.
• Students confuse the English language meaning of similar with the mathematical meaning. It is important to bring out this distinction.

Common Misconceptions

Students have the following misconceptions about similarity:

• “I believe that the two triangles I just drew are similar. First, they are similar because their angle and line segment measuring is not the same, but pretty close. They are also similar because both have two acute angles and one obtuse angle.”
• “My triangles are similar because one is 60 degrees and the other is half of that. Also, some of the measuring are half too. Also, it should be able to fit one of your smaller triangles into the bigger one.”
• “The triangles are similar because all of the angles on both triangles are the same and all of the lengths of the sides are the same making each triangle the exact same in length and degrees.”
• “These triangles are similar triangles. Why are they similar? They are similar because they both are almost the exact same size. They are also both exactly 180 degrees, like all triangles should be. They are also the exact same type of triangle.”
• “The triangles I drew are similar because they both have the same angles, but the length measurements are not the same. So one is bigger than the other but they still have the same angles which makes them congruent.”
• “Why my triangles are similar is because they are not exactly the same. The angle measurements are not exact like the congruent triangles are. They are similar in shape.”
• “My triangles are similar to each other because they both each have 90 degree angles. My triangles’ shapes are similar as well. The vertical line segment is longer than the horizontal line segment. The diagonal line segment is longer than both the horizontal and vertical line segments on each triangle. Finally, the vertices at the top of each triangle are acute.”
• “The triangles in this diagram are very similar because they have the same angles which are at 60 degrees which they equal 180 degrees. All of the sides are 10 cm long in all sides. They are labeled all the same as well. That is why these triangles are similar.”
• “The triangles are similar in many ways. In one they both equal out to 180 degrees. Second, they have three sides. The one triangle is a little bigger but they both equal out to 180 degrees. They both have three sides even though they are different sizes.”
• “These triangles are similar because they have almost the exact same angles and edge or side lengths. But these triangles are different because triangle B is turned backwards and the angles and lengths are different.”
• Students get confused about the relationship of the areas of two similar polygons. They think the value of the ratio of the areas of the figures equals the scale factor instead of the scale factor$^2$.
Triangle ABC
Triangle A'B'C'
Triangle ABC

1. Measure all the line segments in $\triangle ABC$ to the nearest tenth of a centimeter. Write in all the measurements below:

   \[ AB = \underline{\hspace{2cm}} \]
   \[ BC = \underline{\hspace{2cm}} \]
   \[ AC = \underline{\hspace{2cm}} \]

2. Make an altitude in $\triangle ABC$. Measure the altitude in $\triangle ABC$ from vertex C to the nearest tenth of a centimeter and write it below:

   \[ \underline{\hspace{10cm}} \]

3. Measure all the angles in $\triangle ABC$

   Write in all the measurements below:

   \[ m\angle BAC = \underline{\hspace{2cm}} \]
   \[ m\angle ABC = \underline{\hspace{2cm}} \]
   \[ m\angle BCA = \underline{\hspace{2cm}} \]

4. Add up the three measurements of the angle in $\triangle ABC$

   \[ \underline{\hspace{10cm}} \]

5. Find the perimeter of $\triangle ABC$. Show your work

   \[ \underline{\hspace{10cm}} \]

6. Find the area of $\triangle ABC$. Show your work

   \[ \underline{\hspace{10cm}} \]
Triangle A'B'C'

1. Measure all the line segments in \( \Delta A'B'C' \) to the nearest tenth of a centimeter. Write in all the measurements below:

\[
A'B' = \\
B'C' = \\
A'C' = 
\]

2. Make an altitude in \( \Delta A'B'C' \). Measure the altitude in \( \Delta A'B'C' \) from vertex C' to the nearest tenth of a centimeter and write it below:

3. Measure all the angles in \( \Delta A'B'C' \)
Write in all the measurements below:

\[
m \angle B'A'C' = \ \\
m \angle A'B'C' = \\
m \angle B'C'A' = 
\]

4. Add up the three measurement of the angle in \( \Delta A'B'C' \)

5. Find the perimeter of \( \Delta A'B'C' \). Show your work

6. Find the area of \( \Delta A'B'C' \). Show your work
Triangle A"B"C"

1. Measure all the line segments in Δ A"B"C" to the nearest tenth of a centimeter. Write in all the measurements below:

\[ \overline{A''B''} = \underline{\hspace{2cm}} \]
\[ \overline{B''C''} = \underline{\hspace{2cm}} \]
\[ \overline{A''C''} = \underline{\hspace{2cm}} \]

2. Make an altitude in Δ A"B"C". Measure the altitude in Δ A"B"C" from vertex C" to the nearest tenth of a centimeter and write it below:

__________________________________________________________________________

3. Measure all the angles in Δ A"B"C"
Write in all the measurements below:

\[ \angle B''A''C'' = \underline{\hspace{2cm}} \]
\[ \angle A''B''C'' = \underline{\hspace{2cm}} \]
\[ \angle B''C''A'' = \underline{\hspace{2cm}} \]

4. Add up the three measurement of the angle in Δ A"B"C"

__________________________________________________________________________

5. Find the perimeter of Δ A"B"C". Show your work

__________________________________________________________________________

6. Find the area of Δ A"B"C". Show your work

__________________________________________________________________________
COMPARISON OF TRIANGLE ABC AND TRIANGLE A’B’C’

1. What do you notice about the shape of triangle ABC and triangle A'B'C'?

2. What do you notice about the angles in triangle ABC and triangle A'B'C'?

3. Find the value of the ratios of the corresponding sides of triangle ABC and triangle A'B'C'

\[
\frac{AB}{A'B'} = ____ \quad \frac{AC}{A'C'} = ____ \quad \frac{BC}{B'C'} = ____
\]

What do you notice about the value of the ratios of the corresponding sides of triangle ABC and triangle A'B'C'?

THE VALUE OF THESE RATIOS IS CALLED THE SCALE FACTOR

4. What is the scale factor of:

\[
\frac{\Delta ABC}{\Delta A'B'C'} = ____ \quad \frac{\Delta A'B'C'}{\Delta ABC} = ____
\]

5. What do you notice about the value of the ratio of the altitudes of triangle ABC and triangle A'B'C'?

6. What is the value of the ratio of the perimeters of triangle ABC and triangle A'B'C'?

7. What is the value of the ratio of the areas of triangle ABC and triangle A'B'C'?
Part II

Find the perimeter of triangle A"B"C". Show your work

Find the area of triangle A"B"C". Show your work

**COMPARISON OF TRIANGLE ABC AND TRIANGLE A”B”C”**

1. What do you notice about the shape of triangle ABC and triangle A"B"C"?

2. What do you notice about the angles in triangle ABC and triangle A"B"C’?

3. Find the value of the ratios of the corresponding sides of triangle ABC and triangle A"B"C"

   \[
   \frac{AB}{A"B"} = \quad \frac{AC}{A"C"} = \quad \frac{BC}{B"C"} =
   \]

   What do you notice about the value of the ratios of the corresponding sides of triangle ABC and triangle A"B"C’?

**THE VALUE OF THESE RATIOS IS CALLED THE SCALE FACTOR**

4. What is the scale factor of:

   \[
   \frac{\triangle ABC}{\triangle A"B"C"} = \quad \frac{\triangle A"B"C"}{\triangle ABC} =
   \]
5. What do you notice about the value of the ratio of the altitudes of triangle ABC and triangle A"B"C"?

6. What is the value of the ratio of the perimeters of triangle ABC and triangle A"B"C"?

7. What is the value of the ratio of the areas of triangle ABC and triangle A"B"C"?
SUMMARIZE THE CHARACTERISTICS OF THE SIMILAR TRIANGLES

1. ____________________________________________________________________________

________________________________________________________________________________

2. ____________________________________________________________________________

________________________________________________________________________________

3. ____________________________________________________________________________

________________________________________________________________________________

4. ____________________________________________________________________________

________________________________________________________________________________

5. ____________________________________________________________________________

________________________________________________________________________________

6. ____________________________________________________________________________

________________________________________________________________________________
Side-Side-Side (SSS) Similarity
Making and Measuring the Triangles

1. Using a ruler, draw a triangle. Label the vertices A, B, and C

2. Measure each line segment to the nearest tenth of a centimeter. Record the measurements below.
   
   \[
   \begin{align*}
   AB &= \underline{\phantom{100}} \\
   AC &= \underline{\phantom{100}} \\
   BC &= \underline{\phantom{100}}
   \end{align*}
   \]

3. Using a protractor, measure each angle. Record the measurements below.
   
   \[
   \begin{align*}
   \angle BAC &= \underline{\phantom{100}} \\
   \angle ABC &= \underline{\phantom{100}} \\
   \angle ACB &= \underline{\phantom{100}}
   \end{align*}
   \]
   
   Sum of the measures of the three angles = _____________________

4. Pick a scale factor greater than 1: \[ \underline{\phantom{100}} \]

5. Write the reciprocal of the scale factor: \[ \underline{\phantom{100}} \]

6. Take each side measurement of the triangle and multiply it by the chosen scale factor.

<table>
<thead>
<tr>
<th>Side</th>
<th>Original Measurement</th>
<th>Scale Factor</th>
<th>New Side Measurement</th>
<th>New Side Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>AB</td>
<td></td>
<td></td>
<td></td>
<td>A'B'</td>
</tr>
<tr>
<td>AC</td>
<td></td>
<td></td>
<td></td>
<td>A'C'</td>
</tr>
<tr>
<td>BC</td>
<td></td>
<td></td>
<td></td>
<td>B'C'</td>
</tr>
</tbody>
</table>
7. Using a ruler, construct the three new line segments.

A'B'

A'C'

B'C'

8. Using a compass and straight edge, construct the new triangle and label the vertices.
9. Using a protractor, measure each angle. Record the measurements below.

\[ m \angle B'A'C' = \underline{\hspace{2cm}} \]

\[ m \angle A'B'C' = \underline{\hspace{2cm}} \]

\[ m \angle A'C'B' = \underline{\hspace{2cm}} \]

Sum of the measures of the three angles = \underline{\hspace{10cm}}
Investigating the Side-Side-Side (SSS) Similarity Theorem

Definition: If three sides of one triangle are proportional to three sides of a second triangle, then the triangles are similar.

1. Do the triangles have the same shape?

________________________________________________________________________________________________________________________________________

2. Name the corresponding angles of the two triangles.

__________________________________________________  ______________________________________

__________________________________________________  ______________________________________

__________________________________________________  ______________________________________

3. Are the corresponding angles of the two triangles congruent? ______________

4. Name the corresponding sides of the two triangles

__________________________________________________  ______________________________________

__________________________________________________  ______________________________________

__________________________________________________  ______________________________________

5. Determine the values of the ratios of the corresponding sides

<table>
<thead>
<tr>
<th>Lengths of Sides of Smaller Triangle</th>
<th>Lengths of Corresponding Sides of Larger Triangle</th>
<th>Ratio Side of Smaller Triangle to Corresponding Side of Larger Triangle</th>
<th>Ratio Side of Larger Triangle to Corresponding Side of Smaller Triangle</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6. Are the values of the ratios of the corresponding sides congruent? ______________________

7. How are the values of the ratios of the three sides and the scale factor related?

8. Find the perimeter of each triangle. Show your work below.

9. Find the value of the ratio of the perimeter of the large triangle to the perimeter of the small triangle.

10. Find the value of the ratio of the perimeter of the small triangle to the perimeter of the large triangle.

11. How are the values of the ratios for the perimeters related to the scale factor?
12. Find the area of each triangle. Show your work below.

13. Find the value of the ratio of the area of the large triangle to the small triangle.

14. Find the value of the ratio of the area of the small triangle to the large triangle.

15. How are the values of the ratios for the areas related to the scale factor.
16. Write out 5 concepts of similarity explored in this lesson

A. 
B. 
C. 
D. 
E. 

17. State the Side-Side-Side (SSS) Similarity Theorem
If the three sides of one triangle are in the same proportion to the three sides of a second triangle, then the triangles are similar.

1. Get the line segment tool and make a triangle. Get the selection arrow tool and click anywhere on the screen to deselect.

2. Get the text tool and label the triangle’s vertices A, B, and C.

3. Go the Edit Menu, then to Preferences. Select the following settings:
   - Angle Unit: degree
   - Distance Unit: cm
   - Ratios:
   - Precision: units
   - Precision: tenths
   - Precision: hundredths

4. Use the selection arrow tool to measure each side of the triangle to the nearest tenth of a centimeter by selecting all 3 line segments. Go to the Measure Menu, and then select Length. Click anywhere on the screen away from the triangle to deselect. Write the lengths below:

   \[ m\overline{AB} = \ldots \quad m\overline{AC} = \ldots \quad m\overline{BC} = \ldots \]

5. Use the selection arrow tool to measure each angle to the nearest degree by selecting, for example, the points CAB or points BAC to measure angle A. Then go to the Measure Menu and select Angle. Click anywhere on the screen away from the triangle to deselect. Repeat this process for the other two angles:

   \[ m\angle CAB \quad \text{or} \quad m\angle BAC = \ldots \]
   \[ m\angle ABC \quad \text{or} \quad m\angle CBA = \ldots \]
   \[ m\angle ACB \quad \text{or} \quad m\angle BCA = \ldots \]

6. Go to the Edit Menu and choose Select All and copy and paste a copy of the triangle on the same screen. Your new triangle will be labeled triangle DEF.

7. Pick a scale factor. Use a number greater than 1. When you pick a scale factor, pick one such as 1.4 or 2.3, (non integer). The scale factor is the ratio of the corresponding sides. The scale factor tells what factor a side of the original figure must be multiplied by to find the length of the corresponding side in the other figure.

   My scale factor is __________________
8. Go to the **Measure** Menu and select **Calculate**. Click on the length of line segment DF and multiply it by the scale factor you chose. Do the same with line segments ED and FE.

<table>
<thead>
<tr>
<th>Side</th>
<th>Original Measurement</th>
<th>Scale Factor</th>
<th>New Side Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>$DF$</td>
<td>___________</td>
<td>•</td>
<td>___________</td>
</tr>
<tr>
<td>$ED$</td>
<td>___________</td>
<td>•</td>
<td>___________</td>
</tr>
<tr>
<td>$FE$</td>
<td>___________</td>
<td>•</td>
<td>___________</td>
</tr>
</tbody>
</table>

9. Use the **text** tool and type out the lengths the segments should be after the original lengths are multiplied by the scale factor.

10. Then “stretch” the vertices until the sides of triangle DEF are equal to the values you got from the multiplication of the original sides and the scale factor.

11. Make sure that after you “stretch” the side lengths to the required lengths, you check to make sure the corresponding angles are still congruent to the original triangle.

12. Using the **selection arrow** tool, highlight a pair of corresponding sides from the two triangles and go to the **Measure** Menu and select **ratio**. Repeat with the other 2 pairs of corresponding sides.

13. Are the values of the ratios congruent? Write the values below:

   __________________________  _______________________

14. Select all three vertices of one of the triangles and go to the **Construct** Menu and select **Triangle Interior**. Go to the **Measure** Menu and select **Perimeter**. Click anywhere on the screen to deselect. Go back and click on the inside of that same triangle. Go to the **Measure** Menu and select **Area**. Click anywhere on the screen to deselect. Repeat with the other triangle. Write the perimeters and areas of the triangles below.

<table>
<thead>
<tr>
<th>Perimeter</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\triangle ABC$</td>
<td>___________</td>
</tr>
<tr>
<td>$\triangle DEF$</td>
<td>___________</td>
</tr>
</tbody>
</table>
15. Go to the **Measure** Menu and select **Calculate**. Calculate the ratio of the perimeter of the large triangle to the small triangle by clicking on the perimeter of the large triangle, then pressing the division button and clicking on the perimeter of the small triangle. Write the ratio and the value of the ratio below.

16. Go to the **Measure** Menu and select **Calculate** and find out the square of your scale factor.

17. Go to the **Measure** Menu and select **Calculate**. Calculate the ratio of the area of the large triangle to the small triangle by clicking on the area of the large triangle, then pressing the division button and clicking on the area of the small triangle. Write the ratio and the value of the ratio below.

18. Use the text tool and type the SSS Similarity Theorem on your screen.

19. Go to the **File** Menu and select **Print Preview**. Make sure your picture fits all on the screen. You may have to move things around to fit. Then print your screen.
ANGLE-ANGLE (AA) SIMILARITY THEOREM
MAKING AND MEASUREING THE TRIANGLES

If two angles of one triangle are congruent to two angles of another, then the triangles are similar. Notice that AA similarity is equivalent to AAA similarity, since the measure of the third angle of a triangle is known once the measure of two of the angles of the triangle is known.

1. Make a scalene triangle on white paper. Label the angles A, B, and C.

2. Measure the sides of the triangle to the nearest tenth of a centimeter.
   
   \[ \text{AB} = \quad \text{AC} = \quad \text{BC} = \quad \]

3. Take a piece of patty paper and mark a point in THREE of the four corners of this patty paper. Copy the three angles of your original triangle separately onto this patty paper using each point as a vertex of one of the angles. Label the angles \( A' \) (for A), \( B' \) (for B) and \( C' \) (for C). Cut the patty paper into three sections with one angle on each section.

4. Repeat step 3 but this time, keep all three angles on the patty paper and do not cut them onto three separate sections.

5. Arrange the three angles that you cut out on a new piece of white paper to make a triangle. After you tape the first angle down, use a ruler and extend both rays. Line up the next angle anywhere on this extended ray. Tape this angle down. Extend the remaining ray. Tape the last angle at the intersection of both rays. Tape all the angles down on the paper.

6. Take a new piece of white paper and trace the vertices of the taped triangle. Use a ruler to draw it. Label the triangle \( A'B'C' \).

7. Use the piece of patty paper that has the three angles on it and double check the measurements of the angles.

8. Measure each of the new side lengths of the triangle to the nearest tenth of a centimeter. Write the side measurements below.
   
   \[ A'B' = \quad A'C' = \quad B'C' = \quad \]
Investigating the Angle – Angle (AA) Similarity Theorem

Definition: If two angles of one triangle are congruent to two angles of another, then the triangles are similar.

1. Do the triangles have the same shape?

______________________________________________________________________________________________

2. Name the corresponding angles of the two triangles.

__________________  __________________
__________________  __________________
__________________  __________________

3. Are the corresponding angles of the two triangles congruent? ______________

4. Name the corresponding sides of the two triangles

__________________  __________________
__________________  __________________
__________________  __________________

5. Determine the values of the ratios of the corresponding sides

<table>
<thead>
<tr>
<th>Lengths of Sides of Smaller Triangle</th>
<th>Lengths of Corresponding Sides of Larger Triangle</th>
<th>Ratio Side of Smaller Triangle to Corresponding Side of Larger Triangle</th>
<th>Ratio Side of Larger Triangle to Corresponding Side of Smaller Triangle</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6. Are the values of the ratios of the corresponding sides congruent? ______________

7. How are the values of the ratios of the three sides and the scale factor related?

____________________________________________________________________________

____________________________________________________________________________

8. Find the perimeter of each triangle. Show your work below.

9. Find the value of the ratio of the perimeter of the large triangle to the perimeter of the small triangle.

____________________________________________________________________________

10. Find the value of the ratio of the perimeter of the small triangle to the perimeter of the large triangle

____________________________________________________________________________

11. How are the values of the ratios for the perimeters related to the scale factor?

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________
12. Find the area of each triangle. Show your work below.

13. Find the value of the ratio of the area of the large triangle to the small triangle.

14. Find the value of the ratio of the area of the small triangle to the large triangle.

15. How are the values of the ratios for the areas related to the scale factor.
16. Write out 5 concepts of similarity explored in this lesson

A. 

B. 

C. 

D. 

E. 

17. State the Angle – Angle (AA) Similarity Theorem
GEOMETER’S SKETCHPAD
ANGLE - ANGLE (AA) SIMILARITY THEOREM

If two angles of one triangle are congruent to two angles of another, then the triangles are similar. Notice that AA similarity is equivalent to AAA similarity, since the measure of the third angle of a triangle is known once the measure of two of the angles of the triangle are known.

1. Get the line segment tool and make a triangle. Get the selection arrow tool and click anywhere on the screen to deselect.

2. Get the text tool and label the triangle’s vertices A, B, and C.

3. Go the Edit Menu, then to Preferences. Select the following settings:

   - Angle Unit: degree
   - Precision: units
   - Distance Unit: cm
   - Precision: tenths
   - Ratios: Precison: hundredths

4. Use the selection arrow tool to measure each angle to the nearest degree by selecting, for example, the points CAB or points BAC to measure angle A. Then go to the Measure Menu and select Angle. Click anywhere on the screen away from the triangle to deselect. Repeat this process for the other two angles.

   \[ m \angle CAB \text{ or } m \angle BAC = \underline{\hspace{2cm}} \]
   \[ m \angle ABC \text{ or } m \angle CBA = \underline{\hspace{2cm}} \]
   \[ m \angle ACB \text{ or } m \angle BCA = \underline{\hspace{2cm}} \]

5. Use the line segment tool and make a new triangle. Label it D, E, and F.

6. Use the selection arrow tool to measure each angle to the nearest degree by selecting, for example, the points EDF or points FDE to measure angle D. Then go to the Measure Menu and select Angle. Click anywhere on the screen away from the triangle to deselect. Repeat this process for the other two angles.

7. Use the selection arrow tool and drag the vertices until the angles are congruent to triangle ABC.
8. Name all pairs of corresponding sides and all the pairs of corresponding angles between the triangles. The order of the letters in a statement of correspondence tells you which segments and which angles in the two triangles correspond. The symbol for corresponds to is:

<table>
<thead>
<tr>
<th>Angles</th>
<th>Sides</th>
</tr>
</thead>
<tbody>
<tr>
<td>________</td>
<td>________</td>
</tr>
<tr>
<td>________</td>
<td>________</td>
</tr>
<tr>
<td>________</td>
<td>________</td>
</tr>
</tbody>
</table>

9. Using the **selection** arrow tool, highlight a pair of corresponding sides from the two triangles and go to the **Measure** Menu and select **ratio**. Repeat with the other 2 pairs of corresponding sides.

10. Are the values of the ratios congruent? Write the values below.

11. Select all three vertices of one of the triangles and go to the **Construct** Menu and select **Triangle Interior**. Go to the **Measure** Menu and select **Perimeter**. Click anywhere on the screen to deselect. Go back and click on the inside of that same triangle. Go to the **Measure** Menu and select **Area**. Click anywhere on the screen to deselect. Repeat with the other triangle. Write the perimeters and areas of the triangles below.

<table>
<thead>
<tr>
<th>Perimeter</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>ΔABC</td>
<td></td>
</tr>
<tr>
<td>ΔDEF</td>
<td></td>
</tr>
</tbody>
</table>
12. Go to the **Measure** Menu and select **Calculate**. Calculate the ratio of the perimeter of the large triangle to the small triangle by clicking on the perimeter of the large triangle, then pressing the division button and clicking of the perimeter of the small triangle. Write the ratio and the value of the ratio below.

13. Go to the **Measure** Menu and select **Calculate** and find out the square of your scale factor.

14. Go to the **Measure** Menu and select **Calculate**. Calculate the ratio of the area of the large triangle to the small triangle by clicking on the area of the large triangle, then pressing the division button and clicking on the area of the small triangle. Write the ratio and the value of the ratio below.

15. Use the text tool and type the AA Similarity Theorem on your screen.

16. Go to the **File** Menu and select **Print Preview**. Make sure your picture completely fits all on the screen. You may have to move things around to fit. Then print your screen.
SIDE - ANGLE-SIDE (SAS) SIMILARITY THEOREM
MAKING AND MEASURING THE TRIANGLES

If, in two triangles, the ratios of two pairs of corresponding sides are equal, and the included angles are congruent, then the triangles are similar.

1. Using a ruler, draw an angle using segments to represent two sides and the included angle of a triangle. Label the angle A and the endpoints, B and C. Do not connect the third side.

2. Measure the angle to the nearest degree and the two sides to the nearest tenth of a centimeter.

\[ m \angle CAB = \quad \quad AB = \quad \quad AC = \quad \quad \]

3. Pick a scale factor smaller than 1.

4. Take the two side measurements of the triangle and multiply them by the scale factor.

<table>
<thead>
<tr>
<th>Side</th>
<th>Original Measurement</th>
<th>Scale Factor</th>
<th>New Side Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>( AB )</td>
<td>____________          •        _________</td>
<td>=         _________</td>
<td>for ( A'B' )</td>
</tr>
<tr>
<td>( AC )</td>
<td>____________          •        _________</td>
<td>=         _________</td>
<td>for ( A'C' )</td>
</tr>
</tbody>
</table>

5. Use a ruler and draw segments \( A'B' \) and \( A'C' \)

\[ A'B' \]

\[ A'C' \]

6. Use a compass and straight edge to construct \( \triangle A'B'C' \) on a separate sheet of white paper.
7. Measure each line segment to the nearest tenth of a centimeter.

AB = ____________  A'B' = ____________
AC = ____________  A'C'' = ____________
BC = ____________  B'C' = ____________

8. Using a protractor, measure each angle.

m ∠BAC = ____________  m ∠A'B'C'' = ____________

m ∠ABC = ____________  m ∠A'B'C' = ____________

m ∠BCA = ____________  m ∠B'C'A' = ____________
Investigating the Side-Angle-Side (SAS) Similarity Theorem

Definition: If in two triangles the ratios of two pairs of corresponding sides are equal, and if the included angles between those two sides are congruent, then the triangles are similar.

1. Do the triangles have the same shape? ________________________________

2. Name the corresponding angles of the two triangles.
   ___________________  ___________  ___________________  ___________
   ___________________  ___________  ___________________  ___________
   ___________________  ___________  ___________________  ___________

3. Are the corresponding angles of the two triangles congruent? __________

4. Name the corresponding sides of the two triangles
   ___________________  ___________  ___________________  ___________
   ___________________  ___________  ___________________  ___________
   ___________________  ___________  ___________________  ___________

5. Determine the values of the ratios of the corresponding sides

<table>
<thead>
<tr>
<th>Lengths of Sides of Smaller Triangle</th>
<th>Lengths of Corresponding Sides of Larger Triangle</th>
<th>Ratio Side of Smaller Triangle to Corresponding Side of Larger Triangle</th>
<th>Ratio Side of Larger Triangle to Corresponding Side of Smaller Triangle</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6. Are the values of the ratios of the corresponding sides congruent? ______________________

7. How are the values of the ratios of the three sides and the scale factor related? ____________________________________________________________

8. Find the perimeter of each triangle. Show your work below.

9. Find the value of the ratio of the perimeter of the large triangle to the perimeter of the small triangle.

10. Find the value of the ratio of the perimeter of the small triangle to the perimeter of the large triangle.

11. How are the values of the ratios for the perimeters related to the scale factor?
12. Find the area of each triangle. Show your work below.

13. Find the value of the ratio of the area of the large triangle to the small triangle.

14. Find the value of the ratio of the area of the small triangle to the large triangle.

15. How are the values of the ratios for the areas related to the scale factor.
16. Write out 5 concepts of similarity explored in this lesson

A. 

B. 

C. 

D. 

E. 

17. State the Side-Angle-Side (SAS) Similarity Theorem
GEOMETER’S SKETCHPAD
SIDE - ANGLE - SIDE (SAS) SIMILARITY THEOREM

If, in two triangles, the ratios of two pairs of corresponding sides are equal, and the included angles are congruent, then the triangles are similar.

1. Get the line segment tool and make an angle. Get the selection arrow tool and click anywhere on the screen to deselect.

2. Get the text tool and label the angle A, B, and C. Make sure the vertex of the angle is labeled A.

3. Go the Edit Menu, then to Preferences. Select the following settings:
   - Angle Unit: degree
   - Distance Unit: cm
   - Ratios: Precision: hundredths

4. Use the selection arrow tool to measure each angle to the nearest degree by selecting, for example, the points CAB or points BAC to measure angle A. Then go to the Measure Menu and select Angle. Click anywhere on the screen away from the triangle to deselect.

   \[ m \angle CAB \text{ or } m \angle BAC = \underline{\hspace{2cm}} \]

5. Use the selection arrow tool and highlight segment AB and AC. Go to the Measure Menu and select Length. Click anywhere on the screen away from the angle to deselect.

   \[ AB = \underline{\hspace{2cm}} \text{ and } AC = \underline{\hspace{2cm}} \]

6. Pick a scale factor smaller than 1.
   
   My scale factor is: \underline{\hspace{2cm}}

7. Go to the Edit Menu and choose Select All. Copy and paste a copy of the angle onto the same screen. Label this angle D, E, F. Make sure the vertex is labeled D.

8. Go to the Measure Menu and select Calculate. Click on the length of line segment DF and multiply it by the scale factor you chose. Do the same with line segment ED.

   \[
   \begin{array}{ccc}
   \text{Side} & \text{Original Measurement} & \text{Scale Factor} & \text{New Side Measurement} \\
   \hline
   DF & \underline{\hspace{2cm}} & \cdot \underline{\hspace{2cm}} & = \underline{\hspace{2cm}} \\
   ED & \underline{\hspace{2cm}} & \cdot \underline{\hspace{2cm}} & = \underline{\hspace{2cm}} \\
   \end{array}
   \]
9. Use the **text** tool and type out the lengths the segments should be after the original lengths are multiplied by the scale factor.

10. Then “shrink” the vertices until the sides of the angle are equal to the values you got from the multiplication of the original sides and the scale factor.

11. Make sure that after you “shrink” the side lengths to the required lengths, you check to make sure the corresponding angle is still congruent to the original angle.

12. Use the **selection arrow** tool and highlight the two endpoints of one of the angles, go to the **Construct** Menu and select **Segment**. Repeat with the other angle. Now you have two triangles on the screen.

13. Using the **selection arrow** tool, highlight a pair of corresponding sides from the two triangles (go from the smaller triangle to the larger triangle) and go to the **Measure** Menu and select **ratio**. Repeat with the other 2 pairs of corresponding sides.

14. Are the values of the ratios congruent? Write the values below:

   ____________________ _______________________

15. Select all three vertices of one of the triangles and go to the **Construct** Menu and select **Triangle Interior**. Go to the **Measure** Menu and select **Perimeter**. Click anywhere on the screen to deselect. Go back and click on the inside of that same triangle. Go to the **Measure** Menu and select **Area**. Click anywhere on the screen to deselect. Repeat with the other triangle. Write the perimeters and areas of the triangles below.

<table>
<thead>
<tr>
<th>Perimeter</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>ΔABC</td>
<td></td>
</tr>
<tr>
<td>ΔDEF</td>
<td></td>
</tr>
</tbody>
</table>

16. Go to the **Measure** Menu and select **Calculate**. Calculate the ratio of the perimeter of the large triangle to the small triangle by clicking on the perimeter of the large triangle, then pressing the division button and clicking on the perimeter of the small triangle. Write the ratio and the value of the ratio below.

17. Go to the **Measure** Menu and select **Calculate** and find out the square of your scale factor.
18. Go to the **Measure** Menu and select **Calculate**. Calculate the ratio of the area of the large triangle to the small triangle by clicking on the area of the large triangle, then pressing the division button and clicking on the area of the small triangle. Write the ratio and the value of the ratio below.

19. Use the **text** tool and type the SAS Similarity Theorem on your screen.

20. Go to the **File** Menu and select **Print Preview**. Make sure your picture fits all on the screen. You may have to move things around to fit. Then print your screen.
SSS SIMILARITY, AA SIMILARITY, AND SAS SIMILARITY

I. Study the two triangles below. Identify what similarity theorem can be used to determine similarity.

![Triangles](image)

a. **Similarity Theorem:** ____________

b. Find the measure of angle A and angle D

\[ m\angle C = \quad \text{m} \angle D = \quad \]

c. Measure all the sides of the triangles to the nearest tenth of a centimeter. Write the measurements by the sides in the diagram.

d. Show that the value of the ratios of the corresponding sides are congruent. (Larger Triangle to Smaller Triangle)

\[ \frac{\text{Perimeter } \triangle ABC}{\text{Perimeter } \triangle DEF} \]

e. Show that the corresponding angles are congruent

\[ \frac{\text{Angle } A}{\text{Angle } D} \]

f. What is the scale factor?______________________________________

g. Find the perimeter of both triangles. Show your work.

Perimeter $\triangle$ ABC  Perimeter $\triangle$ DEF
h. Show that the value of the ratio of the perimeters is equal to the scale factor. (Larger to Smaller)

i. Measure the altitudes of both triangles to the nearest tenth of a centimeter.

Altitude $\triangle ABC$ from vertex A

Altitude $\triangle DEF$ from vertex D

j. Find the area of both triangles. Show your work.

Area $\triangle ABC$

Area $\triangle DEF$

k. What is the $(\text{Scale Factor})^2$

l. Show that the value of the ratio of the area is equal to the $(\text{Scale Factor})^2$ (Larger to Smaller)
II. Study the two triangles below. Identify what similarity theorem can be used to determine similarity.

a. **Similarity Theorem**: _______________________

b. Find all the angle measurements in both triangles. Write them by the angles.

c. Show that the corresponding angles are congruent.

   ____________________________

   ____________________________

   ____________________________

d. Show that the value of the ratios of the corresponding sides are congruent, (Larger to Smaller)

   ____________________________


e. What is the scale factor? ____________________________

f. Find the perimeter of both triangles. Show your work.

Perimeter $\triangle ABC$                               Perimeter $\triangle DEF$
g. Show that the value of the ratio of the perimeters is equal to the scale factor. (Larger to Smaller)

h. Measure the altitudes of both triangles (one from vertex A and the other from vertex D) to the nearest tenth of a centimeter.

I. Find the area of both triangles. Show your work.

| Area $\triangle ABC$ | Area $\triangle DEF$ |

j. What is the (Scale Factor)$^2$ ________________________________

k. Show that the value of the ratio of the areas is equal to the (Scale Factor)$^2$ (Larger to Smaller)
III. Study the two triangles below. Identify what similarity theorem can be used to determine similarity.

a. **Similarity Theorem:** ___________________________

b. Find the measure of all the angles. Write the measurements by the angles in the diagram.

c. Measure the last side of each triangle. Write the measurements by the sides in the diagram.

d. Show that the value of the ratios of the corresponding sides is congruent. (Larger to Smaller)

e. Show that the corresponding angles are congruent.

   ______________________________________________________________________

   ______________________________________________________________________

   ______________________________________________________________________

f. What is the scale factor? _____________________________________________

g. Find the perimeter of both triangles. Show your work.

   Perimeter $\triangle ABC$                   Perimeter $\triangle DEF$


M-GLAnCE – 7th Grade – Session 4 – Similarity – Participant Packet
Page 46 Revised 10.15.07
h. Show that the value of the ratio of the perimeters is equal to the scale factor. (Larger to Smaller)

i. Measure the altitudes of both triangles (one from vertex A and one from vertex D) to the nearest tenth of a centimeter.

j. Find the area of both triangles. Show your work.

Area $\triangle ABC$  

Area $\triangle DEF$

k. What is the $(\text{Scale Factor})^2$? ________________________________

l. Show that the value of the ratio of the areas is equal to the $(\text{Scale Factor})^2$. (Larger to Smaller)
SIMILAR TRIANGLES

How tall is a tree in your backyard? You could find the answer to this question by climbing a ladder and measuring the tree with a tape measure; however, the tree probably won’t support you at the top! Since the tree is outside, you can use shadows to help estimate the height.

On a sunny day, an object casts a shadow. If you hold a meter stick perpendicular to the ground, it will also cast a shadow. The diagram below shows two triangles. One is formed by an object, its shadow, and an imaginary line. The other is formed by a meter stick, its shadow, and an imaginary line. These two triangles are similar. WHY?

Use what you know about similar triangles to find the height of the flag pole.
Steve has been training for the swim team. He lives at a lake and would like to know how far across the lake he swims each morning. His dad’s friend is a surveyor and makes the following drawing for him.

![Diagram of the lake and measurements]

The surveyor told Steve that \( \overline{BC} \parallel \overline{DE} \) and that points A, B and D were on the same segment and points A, C, and E were on the same segment.

1. Name the two similar triangles, using the correct correspondences, and justify your solution.

2. What is the scale factor from the large triangle to the small triangle?

3. What is the distance across the pond (measured along BC)?
USING SIMILARITY

1. Each dimension of a parallelogram is increased to three times its original size to form a similar parallelogram. If the new parallelogram has an area of 729 square units, what is the number of square units in the area of the original parallelogram?

2. A person who is 5 feet 6 inches tall casts a shadow that is 30 inches. At the same time, a building casts a 32 foot shadow. How many feet tall is the building? Express your answer rounded to the nearest whole number.

3. When the number of square units in the area of a square is quadrupled, by what factor is its perimeter increased?
4. 

A. Why are these triangles similar? Justify your answer.

B. What is the number of inches in the sum of the perimeters for the two triangles?

5. James wants to choose a height for his son's basketball hoop that is in the same proportion to his son's height as the standard 10 foot hoop is to the average 6 foot 6 inch professional basketball player. His son is 4 feet 3 inches tall. What is the number of inches he should put the hoop above the ground to stay in that same proportion?
SCALE DRAWING IDEAS

Mini Me:

1.) Have the students measure in centimeters their arms, legs, hands, etc. You can have them break down the measurements on their leg, e.g. knee to ankle.

2.) Pick a scale factor smaller than 1.

3.) Make a mini version of themselves with a variety of art supplies. Some used clay, pipe cleaners, cardboard, etc.

Cartoon Similarity:

1.) Have the students bring in a cartoon.

2.) Draw the cartoon on 1 centimeter grid paper.

3.) Use 2 centimeter grid paper and enlarge the cartoon.

4.) Go through similarity concepts with their cartoons. Let the students pick something to measure in the cartoons.
   - Same shape
   - Value of the ratios of the measured parts of the cartoon are congruent
   - Corresponding angles are congruent
   - The value of the ratio of the perimeter is equal to the scale factor
   - The value of the ratio of the area is equal to the scale factor squared

Model Car Scale Factors

1.) Provide for the students MATCHBOX cars. You have to be careful because not all model cars have the scale factor on the bottom.

2.) Have the students measure the length, width, and height of the model cars.

3.) Use the scale factor to determine the actual dimensions
Shaquille O’Neal Footprint

Shaquille O’Neal, a basketball player in the NBA, is a very large person. He wears a size 20 shoe. Using ratios, you can find Shaq’s hand span and make comparisons to your own hand span.

1.) Measure the foot length and hand span of 10 students.

2.) Using the average ratios of foot length to hand span, calculate the hand span of Shaquille O’Neal.

3.) Using graph paper, graph the foot length and hand span information.

4.) Extend the axis for foot length to include Shaquille O’Neal’s 41 cm foot.

5.) Draw a line of best fit for the graphed data.

6.) Locate the foot length and corresponding hand span for Shaquille O’Neal on the line.
<table>
<thead>
<tr>
<th>Grade 7: Participant – Similarity</th>
<th>Description of Activity</th>
<th>Materials/Transparencies/Handouts</th>
<th>Key Tips for the Teacher</th>
</tr>
</thead>
</table>
| Exploring Similarity             | Students will develop the meaning of similarity by measuring triangles to determine if the corresponding angles are congruent, the value of the ratio of the corresponding sides are congruent and the value of the ratio of the area is the scale factor. | Lab Packet (2 copies of the 3 triangles) pp 5 – 14  
Rulers  
Protractors  
Scissors  
Colored Pencils | After the students have measured the sides and angles of the triangles, check the measurements as a group to be sure everyone’s measurements are approximately the same. Do this prior to developing similarity.  
Make sure to help the students realize when they are tracing the smaller triangle in each of the larger ones, they will have to flip and turn the triangle to see how many fit in. |
| Exploring SSS Similarity, AA Similarity, and SAS Similarity | Students will use patty paper, rulers and protractors to explore SSS, AA, and SAS similarity. | Patty Paper  
Rulers  
Scissors  
Lab Packet pp 15 – 45  
White Paper | Since the students have already developed the conditions of similarity, keep the chart paper visible so they can refer to it.  
Emphasize the importance of accuracy in measurement. |
| Problem Solving with similarity and scale drawings. | Students will solve routine and non-routine problems involving similarity. | Lab packet pp 46 – 53  
Calculators | Have the students work in groups to solve the problems. They can use calculators. |